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Hardware Description Language

e A high-level programming language offering
special constructs to model microelectronic
circuits

— Describe the operation of a circuit at various level of
abstraction

e Behavior
e Function
e Structure

— Describe the timing of a circuit

— Express the concurrency of circuit operation
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Levels of Abstraction

e Behavioral Level (Architectural / Algorithmic Level)
— Describes a system by the flow of data between its functional blocks
— Defines signal values when they change

e Register Transfer Level (Dataflow Level)

— Describe a system by the flow of data and control signals between and
within its functional blocks

— Defines signal values with respect to a clock

— RTL (Register Transfer Level) is frequently used for the Verilog
description with the combination of behavioral and dataflow constructs
which is acceptable to logic synthesis tools.

e Gate Level (Structural)
— A model that describes the gates and the interconnections between them
e Transistor/Switch/Physical Level

— A model that describes the transistors and the interconnections between
them
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VLSI Design Flow

Behavioral
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(C++,Behavioral Verilog)
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(Gate-level Verilog)
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Layout
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System Specification
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Functional
(Architecture) Design
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\

Fabrication & Testing

Logic Design
|
Logic Verification
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Physical Design
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Event Simulation of a Verilog Model

e Compilation

— Compilation and elaboration
e Initialization

— Initialize module parameters

e Set other storage element to unknown (X) state

— Unknown or un-initialized

* Set undriven nets to the high-impedance (Z) state
— Tri-state or floating

e Simulation
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Verilog Simulation

Circuit Description Testfixture

module FA(s,cout,a,b,cin);

module testfixture;
output s;

Reg a,b;

endmodule endmodule

Verilog Simulator

Verilog Parser

Simulator Engine User Interface

Graphical Simulation Results

|| Text Mode Simulation Results |
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Scenario

Device under Test (DUT)

Uo
Stimulus -~ A9tk ouT GRespon.?e
& . p - bsel ﬁ eneration
ontrol J

EL

i

g out OUT"
sel
-
b out p= SEL'
sel
1
SMUX Module + Testbench
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Logic Function in Verilog

e Combinational logic
~ logic function: out = a-sel + b-sel’
— assign out = (a&sel) | (b&(~sel));
e Basic logic operator
- AND: &
- OR: |
- NOT: ~

Hsi-Pin Ma
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Verilog Module

module name declaration

\

\
module smux(out, a, b, sel);
output out;

input a,b,sel;

endmodule

12
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Verilog Testbench

#10 A=0;B=0;SEL=1;
#10 A=0;B=1,SEL=0;
#10 A=0;B=1,SEL=1;
#10 A=1,B=0;SEL=0;
#10 A=1,B=0;SEL=1;
#10 A=1,B=1,SEL=0;
#10 A=1;B=1,SEL=1;

module test_smux; module J1ame declaration
oo E- wire OUT,; '
I/O definition | reg ABSEL;
module instantiation E smux U0(.out(OUT),.a(A),.b(B),.sel(SEL)) .
‘| initiad ] '
E begin
5 A=0;B=0;SEL=0;

apply stimulus

Hsi-Pin Ma endmodule 13
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Two Primary Constructs

e continuous assignments

— begin with an assign keyword, and can represent simple
combinational logics

e always procedure blocks

— A procedure block encapsulates one or more lines or

programming statements, along with information about
when the statements should be executed

Hsi-Pin Ma
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Continuous Assignments

e assign continuous construct

— combinational logics

module SMUX (out,a,b,sel);
output out;
input a,b,sel;

assign out = (a&sel) | (b&(~sel));

endmodule

This out has to be declared as “wire” or or “output” data type.
This expression can not be inside always @().

Hsi-Pin Ma
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always Procedure Block

e always statements

module SMUX (out,s,b,sel);
output out;

input a,b,sel;

reg out;

always @*
out = (a&sel) | (b&(~sel));

endmodule

Bl

v2

se|+——-

D_Lﬂf out

)

Ul

This out has to be declared as “reg” data type.
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Operators (1/3)

Bitwise Operators

oP Usage Description
~ ~m Invert each bit of m
& m&n AND each bit of m with each bit of n
| m|n OR each bit of m with each bit of n
A m ~ n Exclusive OR each bit of m with n
~ o | m~~normA~n | Exclusive NOR each bit of m with n

Unary Reduction Operators

oP Usage Description
& &m AND all bits in m together (1-bit result)
~& ~&m NAND all bits in m together (1-bit result)
| m OR all bits in m together (1-bit result)
~| ~|m NOR all bits in m together (1-bit result)
A m Exclusive OR all bits in m (1-bit result)
~/Nor A | ~Amor A~m | Exclusive NOR all bits in m (1-bit result)
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Operators (2/3)

Arithmetic Operators

Logical Operators
OP | Usage Description

OP | Usage Description
+ m +n Add ntom

! Im Is m not true? (1-bit True/False result)
- m - n Subtract n from m

&& | m&&n | Are both m and n true? (1-bit True/False result)
- -m Negate m (2's complement)

I mil|n Are either m or n true? (1-bit True/False result)
m *n Multiply m by n

/ m/n Divide m by n

The divisgr for divide operator may be restricted to constants and a power of 2

% m % n Modulus of m / n

Synthesis not supported

Equality Operators (compares logic values of 0 and 1)

OP Usage Description

== m == n Is m equal to n? (1-bit True/False result)

I= m !=n Is m not equal to n? (1-bit True/False result)

Identity Operators (compares logic values of 0, 1, x, and z)

oP Usage Description
=== m ===n Is m identical to n? (1-bit True/False result) Synthesis not supported
|== m !==n Is m not identical to n? (1-bit True/False result) SYm'hTSiS not supported

Hsi-Pin Ma 19
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Operators (3/3)

Relational Operators
OP Usage Description Logical Shift Operators
< m<n | Ism less than n? (1-bit True/False result) OP | Usage Description
> m>n | Ism greater than n? (1-bit True/False result) == m <<n | Shift m left n-times
>> m >> n Shift m right n-times
<= m <=n | Is m less than or equal to n? (True/False result)
>= m >=n | Is m greater than or equal to n? (True/False result)
Misc Operators
OP | Usage Description
?: sel?m:n If sel is true, select m: else select n
{} {m,n} Concatenate m to n, creating larger vector
{1 {n{m}} Replicate m n-times
Hsi-Pin Ma
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Logic Modeling and Simulation Using
Xilinx Vivado
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. Desian - Design Verification
e General design flow o
. . gghalviqral
— Design construction - e
Synthesis
— Behavioral simulation
L. : > Simalation
— Design implementation o e
— Timing simulation Back Timing
Annotation Simulation
e HDL-based design Flow ——— —
Programming Verification

Hsi-Pin Ma 22



NTHU EE

Laboratory for
Reliable
Y Computing

Important Notes

e Draw schematic first and then construct

Verilog codes.

e Verilog RTL coding philosophy is not the same as
C programming
— Every Verilog RTL construct has its own logic mapping (for
synthesis)

— You should have the logics (draw schematic) first and then
the RTL codes

— You have to write synthesizable RTL codes

Hsi-Pin Ma 23
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_ Open Vivado

Vivado

¢ Vivado 2019.2
Eile  Flow Tools Window Help J Q- Quick Access

VIVADO? £ XILINX.

HLx Editions

Recent Projects
Q U | C k Sta rt binary_counter
C:/Users/hp/LD/binary_counter

nsw
C:/Users/hp/LD/nsw

Create Project >

Open Project >
Open Example Project > stopwatch
C:/Users/hp/LD/stopwatch

shift_reg
C:/Users/hp/LD/shift_reg

ssd
C:/Users/hp/LD/ssd

Tcl Console

Hsi-Pin Ma 24
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Open Ner:z De~inat £1 /2)

4 Vivado 20192 7 ;
File Flow Tools  Window Help Q- Quick Access VlVADO

VIVADO!

HLx Editions

Create a New Vivado Project
This wizard will guide you through the creation of a new project.

To create a Vivado project you will need to provide a name and a location for your project files. Next, you
will specify the type of flow you'll be working with. Finally, you will specify your project sources and
choose a default part.

Double Click 7
Q uic k Start Project Name

Enter a name for your project and specify a directory where the project data files will be stored.

Create Project >

Open Project >

Open Example Project > Project name: @nux)

Project locatior_C:/Users/hp/LD

Create project subdirectol
Ta S kS Project will be created at: GyUsers/hp/LD/smux

Manage IP >
Open Hardware Manager >
Xilinx Tcl Store >

Learning Cente

Documentation and Tutorials >
Quick Take Videos >

Release Notes Guide >

®

Tcl Console

X

Hsi-Pin Ma
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#  New Project
Project Type
Spedify the type of project o create.

Open New Project (2/3)

¢

RTL Project
You will be able to add sources, create block designs Integ) 4 Mew Project e
and analysis,

[] Do not spedfy sources at this time ault Part
ose a default Xilinx part or board for your project. This can be changed later. '
() Post-synthesis Project: You will be able to add sources, view de
Do not specfy sources at this time 1
o not spedty rces a im Sele ' @ Boards
() U/ Planning Project 4 Filter
Do not spedfy design sources. You will be able to view part/pad Btk coleguny: | Al - ‘ el ol <E \Lb
() Imported Project Eamily: @ﬁx-? j} Temp grade: ’ All Remaining - |
Create a Vivado project from a Synplfy, XST or ISE Project File
padage: g2 P
e
Create a new Vivado project from a predefined template. Reset All Filters
Search: ’Q* xc7a35tcp v | {1 match)
I/O Pin Block ) GTPE2 Gb Available LUT
D
4 NewProject X art Count RAMs DSPs FlipFlops Transceivers Transceivers IOBs Elements
New Project Summary |- xc7a35tpg236-1 50 Joo 41600 20800
/
V Ivﬁgg (@ A new RIL project named 'lab 1’ wil be created.
(@) The default part and product family for the new project:
syt
g o136
Speed Grade: -1
4 >
L] L]
& XILINX FlnlSh
- I <gack ([_Next> D Finich
© <Back Nexf> Bncel ]
v

Hsi-Pin Ma
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en New Project (3

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 - X
File  Edit Flow Tools Reports Window Layout View  Help Q- Quick Access Ready
r-"‘ h LU < BN == Default Layout v
Flow Navigator e el PROJECT MANAGER - smux ? X
Vv PROJECT MANAGER .
Sources ?2 008X Project Summary 200 X
#’ Settings )
Q T =2 + 0 o Overview | Dashboard
Add Sources PN
Design Sources i
Language Templates > = Constraints Settings  Edit
iF p Catalog > Simulation Sources Project name: smux
> Utility Sources Project location: C:/Users/hp/LD/smux
Product family: Artix-7
v IP INTEGRATOR .
Project part: xc7a35tcpg236-1
Create Block Design Top module name: Not defined
Open Block Design Target language: Verilog
77777777777777777777777777777777777777777777777777777777777777777777777 Simulator language: Mixed
Generate Block Design Hierarchy Libraries Compile Order
Synthesis Implementation
v SIMULATION Properties ?2 00X
Run Simulation o Status: Not started Status: Not started
Messages: No errors or warnings Messages: No errors or warnings
Part: xc7a35tcpg236-1 Part: xc7a35tcpg236-1
v
RTL ANALYSIS Strategy: Vivado Synthesis Defaults Strategy: Vivado Implementation Defaults
> Open Elaborated Design Report Strategy: Vivado Synthesis Default Reports Report Strategy: Vivado Implementation Default Reports
Incremental synthesis: None Incremental implementation: None
Select an object to see properties
Vv SYNTHESIS
P Run Synthesis DRC Violations Timing
> Open Synthesized Design Run Implementation to see DRC results Run Implementation to see timing results
v
v IMPLEMENTATION Tcl Console |Messages |Log Reports |Design Runs X ?-0G
P Run Implementation -
Q z 2 %
> Open Implemented Design . }
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF BRAM URAM DSP Start Elapsed Run Strategy Report Stra
v synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado Syn
' PROGRAM AND DEBUG impl_1  constrs_1 Not started Vivado Implementation Defaults (Vivado Implementation 2019)  Vivado Imp
¥ii Generate Bitstream
> Open Hardware Manager
< >

Hsi-Pin Ma 27
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¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2

File  Edit Flow  Tools
=

2
Flow Navigator 2

v PROJECT MANAGER
#’ Settings
Add Sources
Language Templates

iF 1p Catalog

IP INTEGRATOR

Create Block Design
Open Block Design

Generate Block Design

v SIMULATION

Run Simulation

Vv RTL ANALYSIS

> Open Elaborated Design

Vv SYNTHESIS
P Run Synthesis

> Open Synthesized Design

v IMPLEMENTATION

» Run Implementation

> Open Implemented Design

v PROGRAM AND DEBUG
¥ Generate Bitstream

> Open Hardware Manager

Hsi-Pin Ma

ess and Right"Click

New Source (1/5)

X
Reports ~ Window  Layout View  Help Q- Quick Access Ready
>‘ LI - BN == Default Layout v
4 PROJECT MANAGER - smux ? X
Sources | ‘oject Summary 200 X
o T 2 + Jverview | Dashboard
q Design Sources Hierarchy Update 4 ‘ A
- Settings  Edit
> Constraints { c f h . h
Simulation Source! Refresh Hierarc y Project name: smux
. Project location: C:/Users/hp/LD/smux
>
1P HlerarChy Product family: Artix-7
X . Project part: xc7a35tcpg236-1
Edit Constraints Sets... Top module name: Not defined
. . Target language: Verilog
777777777777777777777777 Edit Simulation Sets... Simulator language: Mixed
Hierarchy Libraries Cq
Add Sources... Alt+A . !
1 Synthesis F
obertes ¢ Add Sources X
/ Add Sources
ADO o S -
This guides you through the process of adding and creating sources for your project
HLX'Bqjtions eports
O Add or create constraints
Select an object to see properties (® Add or create design sources
O Add or create simulation sources
v
Tcl Console |Messages |Log | Reports |DesignRuns X ?2 00
o = =2 %
Name Constraints ~ Status WNS TNS WHS Report Stra
v synth_1 constrs_1 Not started Vivado Syn
impl_1  constrs_1 Not started 9) Vivado Imp
¢ & XILINX ’
v ®
o
(?) Einish
2) 28
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¢ Add Sources

Add or Create Design Sources

and add it to your project.

New Source (2/5)

Specify HDL, netlist, Block Design, and IP files, or directories containing those file types to add to your project. Create a new source file on disk

+

4

¢ Create Source File

Create a new source file and add it to your

project.

Eile type:
File name:

File location: | e <Lo

/?\\

G/

al to Project>

X

Cancek

Copy sources into project

Add sources from subdirectories

Add Files

Add Directories

C

Create File

Scan and add RTL include files into project

below

< Back

Hsi-Pin Ma
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New Source (3/5)

¢ Add Sources

Add or Create Design Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those file types to add to your project. Create a new source file on disk
and add it to your project.

<+

4

In..  Name Library Location

(smux.v xil_defaultlib  <Local to Proje

/

Add Files Add Directories Create File
Scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories
@ < Back Next > Finish Cancel

Hsi-Pin Ma
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New Source (4/5)

¢ Define Module

Define a module and specify 1/0 Ports to add to your source file.
For each port specified:

MSB and LSB values will be ignored unless its Bus column is checked. '
Ports with blank names will not be written.

Module Definition

Module name: |smux

1/0 Port Definitions
+ - 1t

Port Name Direction Bus MSB LSB

\ 4

Hsi-Pin Ma
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New Source (5/5)

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 — X
File Edit Flow TJools Reports Window Layout View Help Q- Quick Access Ready
&, B X > B 8 T X Remember to save files = Defaultlayout v

Flow Navigator z PROJECT MANAGER - smux . ? X
Project Summary X smu X
v PROJECT MANAGER R
Sources ? 00X Project Summary X smux.v X oo
£ Settings .
o = + 0 & C:/Users/hp/LD/smux/smux.srcs/sources_1/new/smux.v C/USQFS/hp/LD/S x/smux.srcs/sources_1/new/smux. X
Add Sources
v Design Sources (1)
Language Templates il B Rl Q x El E' x /I ‘ﬂ’-
A
IF IP Catalog > = Constraints . —
) 1 / CSCrIDL N
> Simulation Sources (1) 1 12 ' // Desc 71plion.
'
v IP INTEGRATOR » ' Utility Sources [T W Description: 13 : V4
. 137 '/ Dependencies.
i ' Jependaencies.
Create Block Design press and double Cllck 14"/ Dependencies: 14 : / cpendaerncic
Open Block Design 157 15 : V4
16 « //Revision: ' .
T P e L LR R R LR R e e L L e e R e N 16 + /Revision:
Generate Block Design Hierarchy  Libraries Compile Order 17 ' : - o o
18 17 '\ //Revision 0.01 - File Created
19 7 ' . ,
Y SIMULATION Source File Properties ?-oox |8 , 18 + // Additional Comments:
2 '
Run Simulation @ smuxy o 21 19 + /
2! 1
N BT rodute smux( WS W////zzzzzzzzzzzzzzzza
v RTLANALYSIS Enabled = :
24 input a,
> Open Elaborated Design Location: C:/Users/hp/LD/smux/smux.srcs/sources_1/new 25 . input b, 21 :
. '
Type: Verilog E] 26 input sel, 22 .
27 1 output out ' .
v SYNTHESIS Library: xil_defaultlib B ) 23 ¢ module smux(
P Run Synthesis Size: 05 KB 29 1 endmodule 24 input a,
30 . . .
> Open Synthesized Design R g !
pen=y J General  Properties < 25 . mput b ’ > h
'
26 ! input sel,
v IMPLEMENTATION Tcl Console  Messages  Log  Reports  DesignRuns X 7 : output out [
» Run Implementation o
P alz|e + % ) ):
> Open Implemented Design . " - : ’
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF BRAM URAM DSP St \ ort Stra
v [ synth_1 constrs_1 Not started N n do Syn
3 5S 10 = ~
v PROGRAM AND DEBUG > impl_1  constrs_1 Not started 30 @Ul (a&sel ) I (b&® do Imp
ii Generate Bitstream 3] :
'
> Open Hardware Manager 32 + endmodule
'
7!
33 4
'
< < >

23:1 | Insert Verilog

Hsi-Pin Ma 32
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Add Testbench (1/5)

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 - X
File  Edit Flow Tools Reports Window Layout View Help Q- Quick Access Ready
r-"‘ =] h LU < BN ¥ == Default Layout v

Flow Navigator 2 ? PROJECT MANAGER - smux ? X
v PROJECT MANAGER
ources 2 — X roject Summary X smux.v X
S ? oo Project S * 200
# Settings
Q = - + 0 & C:/Users/hp/LD/smux/smux.srcs/sources_1/new/smux.v X
Add Sources
v Design Sources (1) o W
-« x B B X // ® Q &
o= mxcnPragg and Right Click: .
2 '/ Description: A~
IF IP Catalog > = Constraints g M
Simulation Sources (1) 14
v IP INTEGRATOR v @ sim_1 (] 4 Add Sources X
0ot :
Create Block Design Hierarchy Update 4
> = Utility Sourc
Refresh H
Open Block Design C  Refresh Hi ' Add Sources
IP Hierarch 4 Vl\AA\DO . . . q q
Generate Block Design I o] YN T e This guides you through the process of adding and creating sources for your project
Hierarchy  Libr Edit ConstraintsSet HLx Editions
it Constraints Sets... —
O Add or create constraints
Edit Simulation Sefy... =
¥ SIMOLATION Source File Propg O Add or create design sources
Run Simulation @ smuxy dd Sources... A _ 9
\> @ Add or create simulation sources
v RTLANALYSIS Enabled
> Open Elaborated Design Location: C:/Users/hp/LD/smux/smux.srcs/sources_1/new
Type: Verilog Iz‘
v SYNTHESIS Library: xil_defaultlib |ZI
P Run Synthesis Size: 06 KB
> Open Synthesized Design | (727 -"5=5 7 77T T T T o n T T T n T n T
General  Properties
Y IMPLEMENTATION Tcl Console |Messages |Log | Reports |DesignRuns X
P Run Implementation -
o = =2 + %
> Open Implemented Design .
Name Constraints ~ Status WNS TNS WHS
v synth_1 constrs_1 Not started
' PROGRAM AND DEBUG impl_1  constrs_1 Not started
¥ Generate Bitstream [v XILINX
> Open Hardware Manager ©
YN
< ) Finis}

Hsi-Pin Ma
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Add Testbench (2/5)

¢ Add Sources

Add or Create Simulation Sources
Specify simulation specific HDL files, or directories containing HDL files, to add to your project. Create a new source file on disk and add it to

your project.
¢ Create Source File X

Specify simulation set: sim_1 v Create a new source file and add it to your
project. '

File type: ® Verilog v

File name: < test_smux.v d
Use Add Files, A File location: | e <Local tp Project> \ v
VAR
'\?/‘ \Cancel

Add Files Add Directories <~ Create File

Scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories

Include all design sources for simulation

/A
? < Back Next > Finish

Cancel

\_/

Hsi-Pin Ma
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Add Testbench (3/5)

¢ Add Sources

Add or Create Simulation Sources
Specify simulation specific HDL files, or directories containing HDL files, to |
your project.

Specify simulation set: sim_1

==

4

In.. Name Library Location

@_smux.v xil_defaultlib  <Local to Project>

¢ Define Module

Define a module and specify I/O Ports to add to your source file.

For each port specified:
MSB and LSB values will be ignored unless its Bus column is checked.

Ports with blank names will not be written.

Module Definition

Module name: |test_smuxi

1/0 Port Definitions

+

Port Name LSB

Direction Bus MSB

v O

input

(=)
\2)
N \

(D (o]

N

Add Files

Add Directories

~N

\\ Create File

Scan and add RTL include files into project
Copy sources into project
Add sources from subdirectories

Include all design sources for simulation

Einmh '

< Back Next >

Cancel

Hsi-Pin Ma
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¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 - X
File  Edit Flow Tools Reports Window Layout View Help Q- Quick Access Ready
|=‘ =] X " S < BN ¥ == Default Layout v
Flow Navigator s ? PROJECT MANAGER - smux ? X
Vv PROJECT MANAGER .
Sources ?2 00X Project Summary  X|smux.v*  X|test.smux.w X 200
£+ Settings ~ | o
Q. = S + 0 & C:/Users/hp/LD/smux/smux.srcs/sim_1/new/test_smux.v X
Add Sources
~ == Design Sources (1
9 " X B B X / Q o
Language Templates @ = smux (smux.) !
v/ /1002020 02:04:00 PM N |
TF IP Catalog > Constraints .
V(= Simulation Sources (2) sy test_smux
. . % L
v P INTEGRATOR ~=sm12 Double Click and Edit | -
. @ . smux (smux.v) Y
Create Block Design 1
Open Block Design > Utility Sources
Generate Block Design Hierarchy Libraries Compile Order 14 !/ Dependencies:
15+ 7
16 + //Revision:
v SIMULATION Source File Properties 175 Revision 0.01
7+ //Revision 0.01 -
Run Simulation ® test smuxy 18 + // Additional Cc
19 7
v RTLANALYSIS Enabled 00/
21
> Open Elaborated Design Location: C:/Users/hp/LD/smux/smux.srcs/sim_1/new 9y
Type: Verilog IZI © module test_smux(
4
v SYNTHESIS Library: xil_defaultlib lz‘ 55 ):
P Run Synthesis Size: 0.5 KB 26 1 endmodule
v ;
> Open Synthesized Design Inmmnrs P o v
General  Properties < >
Y IMPLEMENTATION Tcl Console |Messages |Log |Reports |DesignRuns X ? 00
» Run Implementation - | a
o = =2 + %
> Open Implemented Design . ’
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF BRAM URAM DSP Start Elapsed Run Strategy Report Stra
v [> synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado Syn
' PROGRAM AND DEBUG > impl_1  constrs_1 Not started Vivado Implementation Defaults (Vivado Implementation 2019) ~ Vivado Imp
fi Generate Bitstream
> Open Hardware Manager
< >

Hsi-Pin Ma
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dd Testbench (5/5)

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 — X
File Edit Flow Tools Reports Window Layout View Help Q- Quick Access Ready
=, B X > I < BN ¥ = Default Layout v
Flow Navigator PROJECT MANAGER - smux ? X
v PROJECT MANAGER )
Sources ?2 00X Project Summary X smux.v X test.smux.v* X 200
3 Settings - .
Q, = S + 0 -] C:/Users/hp/LD/smux/smux.srcs/sim_1/new/test_smux.v X
Add Sources .
v Design Sources (1) O W « X ] B X / E Q 5
Language Templates @ smux (smuxy) : B
21 ¢ N |
IF IP Catalog > = Constraints -
v Simulation Sources (2) 3 1 module test_smux();
v IP INTEGRATOR Vv = sim_1(2) 41 wire OUT;
X @ . smux (smux.v) 5 . reg A, B, SEL;
Create Block Design q
@ test_smux (test_smux.v) o
Open Block Design > = Utility Sources 7 smux UO(.a(A), .b(B), .sel(SEL), .out(OUT));
8
Generate Block Design Hierarchy  Libraries ~ Compile Order 9 : initial
0 begin
1.
v SIMULATION i i 2 4 '
Source File Properties - 0o Xx 2 1 A=0;B=0;SEL=0;
Run Simulation ® test smuxy - £ 3 1 #10 A=0;B=0;SEL=1;
N {1 #10 A=0;B=1;SEL=0;
© RTL ANALYSIS Enabled 5 ‘ #10 A=0;B=1:SEL=1;
6+ #10 A=1:B=0:SEL=0;
> Open Elaborated Design Location: C:/Users/hp/LD/smux/smux.srcs/sim_1/new 7 h #10 A=1:B=0:SEL=1:
Type: Verilog B § 1 #10 A=1;B=1;SEL=0;
9 | #10 A=1;B=1;SEL=1;
¥ SYNTHESIS Library: xil_defaultlib EI 0 ' #10 A=0:B=0:SEL=0:
P Run Synthesis Size: 05 KB 1 end
v .
> Open Synthesized Design | 777772577 7 7 T T T T T T ! : N
General  Properties < >
V' IMPLEMENTATION Tcl Console |Messages |Log | Reports |DesignRuns X ?2 00
» Run Implementation - | a
o = =2 + %
> O Impl ted Desi
pen implemented Lesign Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF BRAM URAM DSP Start Elapsed Run Strategy Report Stra
v > synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado Syn
v PROGRAM AND DEBUG > impl_1  constrs_1 Not started Vivado Implementation Defaults (Vivado Implementation 2019)  Vivado Imp
¥ Generate Bitstream
> Open Hardware Manager
< >

Hsi-Pin Ma

34:19 | Insert Verilog
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Simulation (1/4)

¥ Generate Bitstream

> Open Hardware Manager

Vivado Simulator

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 - X
File  Edit Flow Tools Reports ~Window Layout View Help Q- Quick Access Ready
BE B X h S - DN ¥ == Default Layout v
PROJECT MANAGER - smux ? X
v PROJECT MANAGER )
Sources ?2 00X Project Summary X |smux.v X |test.smux.v X 200
# Settings - - i
Q = i + 0 & C:/Users/hp/LD/smux/smux.srcs/sim_1/new/test_smux.v X
Add Sources
[ Design Sources (1) Qo « X B B X N/ B Q o
Language Templates @ = smux (smux.) : -
o1 ~H
IF IP Catalog > Constraints . ,
= Simulation Sources (1) 23 1 module test_smux();
v IP INTEGRATOR v = sim_1(1) 24 1 wire OUT;
i > @ . test smux (test_smux.v) (1) 25+ reg A, B, SEL;
Create Block Design | -
> Utility S . .
ility Sources ¢ Run Simulation X
Open Block Design
Generate Block Design Hierarchy Libraries Compile Order . .
Executing simulate step...
v SIMULATION Source File Properties _
< Run Behavioral Simulation >
Vv RTL ANALYSIS
> Open Elabc Press and Select ux/smux.srcs/sim_1/new Y 410 A=1:B=0:SEL=1:
ﬂ 38 1 #10 A=1;B=1;SE
Vv SYNTHESIS |Z| 39 : #10 A=1;B=1;SEL=1;
40 #10 A=0:B=0:SEL=0;
P Run Synthesis Size 07 KB 41 1 end
v o
> Open Synthesized Design | |70 - """ 7T T TTTTT T m oI T n T 2 v
General  Properties < >
¥ IMPLEMENTATION Tcl Console  Messages Log  Reports  Design Runs X ?2 00
» Run Implementation -
P o = 2 + %
> Open Implemented Design . N
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power Failed Routes LUT FF BRAM URAM DSP Start Run Strategy Report Stra
v > synth_1 constrs_1 Not started Vivado Synthesis Defaults (Vivado Synthesis 2019) Vivado Syn
v PROGRAM AND DEBUG > impl_1  constrs_1 Not started Vivado Implementation Defaults (Vivado Implementation 2019)  Vivado Imp

Hsi-Pin Ma
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imulation (2/4)

¢ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2

Help

| 10

us

File Edit Flow Tools Reports Window Layout View Run
) > B o8 T I
Flow Navigator >3 A SIMULATION - Behavioral Simulation - Functional - sim_1 - test_smux
v PROJECT MANAGER
Scope
o3 Settings a - -
Add Sources
Na.. De.. Bl.
Language Templates 1 tests Verilo
TF IP Catalog smux Verilo
I glbl  Verilo

Vv IP INTEGRATOR

Create Block Design

v SIMULATION

Run Simulation

Vv RTL ANALYSIS

> Open Elaborated Design

v SYNTHESIS
P Run Synthesis

> Open Synthe

Vv IMPLEMENTATION Tel Console

a x =2 I B

P Run Implementation -
P o

S Open

mplemented Design

# run 1000ns

v PROGRAM AND DEBUG xsim: Time (s): cpu = 00:00:05 ;

Objects
o Q

A Na.. Va..
o
v o
vo
vo

v

elapsed = 00:00:06 . Memory (MB): peak = 713.539

- X
° .
Press to maximize
v X C Default Layout v
Untitled 1 P
o
Da... ~
Logic
Logic
Logic
Logic

gain = 11.770

INFO: [USF-XSim-96] XSim completed. Design snapshot 'test_smux_behav' loaded.
INFO: [USF-XSim-97] XSim simulation ran for 1000ns

¥t Generate Bitstream

> Open Hardware Manager

launch_simulation: Time (s): cpu = 00:00:07 ; elapsed = 00:00:16 .

Memory (MB): peak = 713.539 ; gain = 13.695

Sim Time: 1 us

Hsi-Pin Ma
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Use to zoom in or zoom out SiMulation (3 / 4)

SIMULATION - Behlvioral Simulation - Functional - sim_1 - test_smux

999,990 ps 999,992 ps 999,994 ps 999,996 ps 999,998 ps 000, 1,000,010 ps

Objects

Q
]
Q
=
<]
(=9

Scroll this to the begi
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Simulation (4/4)

Press to close simulation

¥ smux - [C:/Users/hp/LD/smux/smux.xpr] - Vivado 2019.2 - X
File  Edit Flow Tools Reports Window Layout View Run  Help Ready
|=‘ }A L - BN « » » us v X Default Layout v

Flow Navigator >3 w2 SIMULATION - Behavioral Simulation - Functional - sim_1 - test_smux
v PROJECT MANAGER B
Untitled 1
£ Settings .
Q W @ o I « I« + &

Add Sources
Language Templates

TF IP Catalog

Vv IPINTEGRATOR

Create Block Design

Vv SIMULATION

Run Simulation

Vv RTL ANALYSIS

> Open Elaborated Design

Vv SYNTHESIS

P Run Synthesis

s C

Vv IMPLEMENTATION

P Run Implementation

s C

v PROGRAM AND DEBUG
¥ Generate Bitstream

> Open Hardware Manager

0

0

0 I I I
0 .

< > <

v
>

Tcl Console | Messages | Log

Hsi-Pin Ma

Sim Time: 1 us
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Types of Verilog Construction
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Verilog Module Construction (1/2)

e Separate flip-flops with other logics (two types)
— flip-flops (edge-triggered with clock, reset)
— combinational logics (level sensitive)
e Combinational logics
— simple logics (AND, OR, NOT)
— coder/decoder (mapping, addressing)
— comparison (conditional /equality test)
— selection (select correct results, MUX)

— arithmetic functions and superposition (+,-,*,binary shift)

e Finite state machine (FSM)

Hsi-Pin Ma
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Verilog Module Construction (2/2)

e Separate flip-flops with other logics

— For a positive-edge-triggered D-type flip-flop with
asynchronous reset

always @(posedge clk or negedge rst_n)
if (~rst_n)
q<=0;
else
q<=d;

Hsi-Pin Ma 44
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F(z,y,2) =Y (1,4,5,6,7) = f

1| input: x,y,z output: £

vz 3
2| |x|y|z|f x\_00 01 11 10
0{0|0]|0 of 0 [[1|] O | O} 3
0(0|1|1 2 f=F(X,y,z):x-|—y’Z
0[1(0]0
0[1|1]0 z
1/0[0]|1
1/0[1|1 X ;
1/1]0]1 %’%_}—Df
1|1(1]1
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F(a?,y, z)

f=F(x,y,z)=x+y’z

Hsi-Pin Ma

module ex(f,x,y,z);
output f;
input x,y,z;

assign f = x| ((~y)&z);

endmodule

> (1,4,5,6,7) = f

module t_ex;

wire f1;
reg x1,y1,z1;

f ex U0(.£(f1),.x(x1),.y(y1),.z(z1));

initial

begin
x1=0;y1=0;z1=0;
#5 x1=0;y1=0;z1=1;
#5 x1=0;y1=1,z1=0;
#5 x1=0;y1=1;,z1=1;
#5 x1=1,y1=0;z1=0;
#5 x1=1,y1=0;z1=1;
#5 x1=1,y1=1;,z1=0;
#5 x1=1,y1=1;z1=1;
#5 x1=0;y1=0;z1=0;

end

endmodule
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=4 Xilinx

File Edit View Project Source Process Test Bench Simylation Window Help =B

Transcript

Hsi-Pin Ma
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T Fx,y,z) = 1,4,5,6,7) =

ISE - C:\ex\ex\ex1.ise - [Simulation]

N3

D (I XXXm Q[ = Bl * X7 00 % v
i L LU B v v

Current Simulatio
Time: 1000 ns
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Example 2 (1/3)

fi =2y z+2y'2 + zyz
= mi + Mg +my = 2(1,4,7)

e Module definition

module expl(fl, X, y, z);
output {1;
input x,y,z;

assign f1 = ((~x)&(~y)&z) | (x&(~y)&(~z) | x&y&z);

endmodule

Hsi-Pin Ma

X y z|h
0O 0 00
0 0 1]1
01 0]0
01 1]0
1 0 0]1
1 0 110
1 1 00
1 1 11
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Example 2 (2/3)

module test f1;
wire out;

reg a,b,c;

[
—

expl UO(.f1(out),.x(a),.y(b),.z(c));

initial

begin
a=0;b=0;c=0;
#10 a=0;b=0;c=1;
#10 a=0;b=1;c=0;
#10 a=0;b=1;c=1;
#10 a=1;b=0;c=0;
#10 a=1,b=0;c=1;
#10 a=1;b=1;c=0;
#10 a=1,b=1;c=1;

end

endmodule

—_ = e e OO O O | X

e s T Y S S o B e T

_ O =k O =) ©o = o lN

_ O O =k OO O = O
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Example 2 (3/3)
e Simulation Results

Behavioral Simulation - Functional - sim_1 - test_f1

E uUntitled 1* X

—
—

_ = == O o o O <
e = =T U S e N e T
—_ O R O R O ~ O |N
_ O O R O O R, O

Hsi-Pin Ma
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Example 3 (1/3)

o = 3y e+ s + s . ap
= ms3 +ms +me +mr = (3,5,6,7) Y 2
0 0 00
e Module definition 0 0 1]0
0O 1 01]0

module exp2(f2, x, y, z);
output f2; 0O 1 1|1
input x,y,z; 1 0 01l0
assign 2 = ((~x)&y&z) | (x&(~y)&z) | ( x&y&(~2))| (x&ey&z); 10 1)1
1 1 01

endmodule

1 1 1)1

Hsi-Pin Ma -
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Example 3 (2/3)

module test (2;
wire out;

reg a,b,c;
exp2 UO(.f2(out),.x(a),.y(b),.z(c));

initial

begin
a=0;b=0;c=0;
#10 a=0;b=0;c=1;
#10 a=0;b=1;c=0;
#10 a=0;b=1;c=1;
#10 a=1;b=0;c=0;
#10 a=1,b=0;c=1;
#10 a=1;b=1;c=0;
#10 a=1,b=1;c=1;

end

endmodule

X vy z|bH
0 0 0]0
0 0 110
0O 1 010
0 1 1]1
1 0 00
1 0 11
1 1 0|1
1 1 1|1

53



Example 3 (3/3)

e Simulation Results

Laboratory for
Reliabl
Computing

BE
H "\ &
0

33 NHLN

est_f2

Behavioral Simulation - Functional - sim

& uUntitled2 x
b

0100

01T1(1

1 0 0]0

1 011

11 0]1
11 1)1
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Example 4: Prime Detector (1/2)

e Spec

— A circuit outputs a 1 when its four-bit input represents a
prime number in binary ‘

c
b — f
a

—f(d,c,b,a)=1 if dcba: is a prime
o Truth table TR

0 0000 0
" 1 0001 1
2 0010 1 abbreviated truth table
3 0011 1
: 0101 ’ 1 0001 1
6 0110 0 2 0010 1
7 0111 1 3 0011 1
8 1000 0 5 0101 1
9 1001 0 7 0111 1
10 1010 0
11 1011 1
11 1011 1
12 1100 0 o . — 1
i o ] Otherwise 0
14 1110 0
Hsi-Pin Ma 15 1111 0 55
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Example 4: Prime Detector (2/2)

e Normal form :

—f(d,c,b,a) =d'cVa+ddba +dcdba+ dcba+ dcba+ dd'ba + deb'a

e Sum of minterms
dcba

~ f(d,e,b,a) =) m(1,2,3,5,7,11,13)

0O 1010 (0 o) IL ) 10XX

(o)

1 ——
D_
D_
)
Di
1__3>7

Hsi-Pin Ma 56
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Verilog Module v1 (assign)

f(d,c,b,a) =da+dcdb+cba—+ c'ba

module prime(isprime, a, b, ¢, d);
output isprime;
input a,b,c,d;

assign isprime= ((~d)&a) | ((~d)&(~c)&b) | (c&(~b)&a) | ((~c)&bé&a));

endmodule

Hsi-Pin Ma
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Verilog Module v2 (case)

let in[3:0]=dcba (bus)

e Use “case”

Hsi-Pin Ma

module prime(isprime, in);

output isprime; //true if input is prime

input [3:0] in; //4-bit input

reg isprime; //for signal to be assigned in always block

always @*
case (in)
1,2,3,5,7,11,13: isprime = 1'b1;
default: isprime = 1'b0;

endcase

endmodule
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Testbench

module test_prime;
wire isprime;

reg [3:0] in;

/ | instantiate module to test

prime UO(.isprime(isprime),.in(in));

initial
begin
in=0; // set to initial value
repeat (16) //loop 16 times
begin
#100 // delay for 100 time unit

$display(“in = %2d isprime = %1b”, in, isprime);

in =in +1; // increment input
end
end

endmodule

59



o  Laboratory for
% i Reliable
- - Computing

- A 2-to-4 Line Decoder
—F—]a § bp——
" a m: . module Dec?4(a, b);

input [1:0] a; / /binary input (2 bits wide)
a1 ap b3 b b1 bo | output[3:0] b; // one-hot output (4 bits wide)

assign b[3]=a[1]&al0];
assign b[2]=a[1]&(~a[0]);
assign b[1]=(~a[1])&al[0];

1 1 1 0 0 0 assign b[0]=(~a[1])&(~a[0]);

4

o

{Z endmodule

S
\V}
|

alaO

—
| —
|

/
alao

ayag

| b

[ = a1a
) 3_19
) b,
D=

~
S
|
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"A BCD to Seven-Segment Display Decoder

A
Flg [
E| e

D P

/ /| define segment codes
“define SS_0 7’b1111110
“define SS_1 7’b0110000
“define SS_2 7’b1101101
“define SS_3 7’b1111001
“define SS_4 7’b0110011
“define SS_5 7'b1011011
“define SS_6 7’b1011111
“define SS_7 7’b1110000
“define SS_8 7’b1111111
“define SS_9 7’b1111011

module sseg(segs, bin);
output [6:0] segs;

input [3:0] bin;

reg [6:0] segs;

always @*

case (bin)
4’d0: segs = "SS_0;
4'd1: segs = "SS_1;
4'd2: segs = "SS_2;
4'd3: segs ="SS_3;
4'd4: segs ="SS_4;
4’d5: segs = "SS_5;
4’de: segs = "SS_6;
4'd7: segs ="SS_7;
4'd8: segs = "SS_8§;
4'd9: segs ="SS_9;
default: segs = 7"b0000000;

endcase

endmodule
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y = max{a, b}
b,
module Max(a, b, y);

input [3:0] a, b; / /two input variables (4 bits wide)
output reg [3:0] y; // maximum output (4 bits wide)

assign gt=(a>b) ? 1 : 0;
always @*
if (gt)
¥y=«
else

y=Db;

endmodule

Hsi-Pin Ma

always @*
if (@a>b)
y=o&
else

y=b;
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Ripple-Carry Adder (1/2)

Laboratory for
i ' Reliable
i ' Gomputi
nputing
cout
an_1 5 cout
Sp_
b FAn-1 s n-t
n-1 b
cin
]
°
®
a; cout
a
S
b FA1 1
1 b
cin
o
ap a cout
S
b FAO :
0 b
cin
cin |
Hsi-Pin Ma

module adder(a, b, cin, cout, s);
parameter n=4;
input [n-1:0] a, b;

input cin;

output reg [n-1:0] s;

output cout;
reg [n-1:0] ¢;

integer i;

assign cout = c[n];

always @*

c[0] = cim;

assign {c[1],s[0]
[2],s[1]
c[3],s[2]
assign {c[4],s[3]

{c[1],sl0]} =
assign {c[2],s[1]} =
assign { s|2]} =

{cl4]s[3]} =

al0] + b[0] + c[0];
a[l] + b[1] + c[1];
al2] + b[2] + c[2];
a[3] + b[3] + ¢[3];

B

always @*

for (i=0;i<n;i=i+1)
{cli+1],s[i]} = a[i] + b[i] + c[i];

endmodule
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Multi-bit Binary Adder (2/2)

cout
an_1 cout
FAn-1 s St
bn—1
cin
@
[ ]
]
ay cout
FA1 s >
b
cin
)
ag cout
FAO s =0
bo
cin
cin |

Hsi-Pin Ma

module Adderl(a, b, cin, cout, s);
parameter n=8;

input [n-1:0] a, b;

input cin;

output [n-1:0] s;

output cout;
assign {cout, s} =a + b + cin;

endmodule
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